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Tuyên bố bản quyền 

Giáo trình này sử dụng làm tài liệu giảng dạy nội bộ trong 

trường Cao đẳng nghề Công nghiệp Hà Nội 

Trường Cao đẳng nghề Công nghiệp Hà Nội không sử 

dụng và không cho phép bất kỳ cá nhân hay tổ chức nào sử dụng 

giáo trình này với mục đích kinh doanh. 

Mọi trích dẫn, sử dụng giáo trình này với mục đích khác 

hay ở nơi khác đều phải được sự đồng ý bằng văn bản của 

trường Cao đẳng nghề Công nghiệp Hà Nội 
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BÀI 1: GIỚI THIỆU PHẦN MỀM FLASH VÀ THIẾT KẾ VẼ CƠ BẢN 

1. Giới thiệu ứng dụng FLASH     

1.1 Các tính năng của ứng dụng 

Tạo ra các đối tượng chuyển động, di chuyển qua khung Stage ( nơi trình chiếu) 

hoặc làm thay đổi hình dáng (Shape), kích thước (Size), màu sắc (Color), hướng xoay 

(Rotation) và các thuộc tính khác. 

Flash cho phép tạo ra các vùng chuyển cảnh cho đoạn phim mà trong đó người 

xem có thể sử dụng bàn phím hay chuột để nhảy đến từng phần khác nhau của đoạn 

phim, di chuyển đối tượng.. 

Tạo ra vùng chuyển cảnh bằng cách thiết lập các Action (hành vi) dùng 

ActionScript. 

1.2 Giao diện làm việc 

a. Vùng Timeline 

Chứa các khung hình chuyển động: 

Layer: Bảng quản lý lớp 

b. Vùng thanh công cụ  Tools 

Vùng thanh công cụ chứa các công cụ để tạo hình, hiệu chỉnh và tạo các hiệu ứng 

cho các đối tượng. 

 

 

 

Hình 1.2.1 Thanh công cụ 
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c. Vùng thanh thuộc tính Properties 

Mỗi một đối tượng đều có thuộc tính riêng như màu viền, loại viền, màu nền… 

Để quản lý các thuộc tính này, Flash bố trí chúng trong một cửa sổ Properties. 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                       Hình 1.2.1 Vùng thuộc tính 

Thuộc tính của vùng soạn thảo Stage bao gồm: 

Publish: 

Player: Cho phép trình chiếu có thể hoạt động tốt trên phiên bản Flash nào. 

Script: Phiên bản ActionScript mà đoạn phim đang sử dụng cho bạn một cú pháp 

khai báo của lớp nội tại – mặc định là lớp kế thừa từ MovieClip. 

Class: Nhập tên lớp thể hiện vào, lập tức Flash sẽ khởi tạo  

Profile: Quản lý các thông tin liên quan đến việc xuất bản dự án Flash. 

AIR Settings: Các cấu hình thiết lập cho dự án Flash chạy trên Adobe Air 

Properties:  
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FPS:  Tốc độ chơi – đo bằng số frame trên mỗi giây Frames Per Second. 

Size : Kích thước của khung chiếu- đo bằng pixel. 

Stage: Quản lý màu nền của khung soạn thảo. 

d. Vùng soạn thảo ActionScript 

Hiển thị cửa sổ Action : Windows / Action (F9) 

Phần soạn thảo nằm ở trung tâm của cửa sổ này. Vùng phía bên trái chứa các lớp 

thư viện và cây phả hệ ( mô tả sự kế thừa của các lớp). Phía trên khung soạn thảo là hệ 

thống các công cụ hỗ trợ soạn thảo ActionScript. 

  

 

 

 

 

 

 

 

 

 

 

 

(1): Bổ sung các thành phần vào cửa sổ ActionScript 

(2): Tìm kiếm và thay thế. 

(3): Chèn target path. Chức năng này thường được sử dụng khi làm việc với lớp. 

(4): Kiểm tra lỗi cú pháp. 

(5): Định dạng cho mã nguồn theo chế độ tự động của ActionScript. 
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(6): Xem các chỉ dẫn về mã nguồn. 

(7): Tạo các kiểm thoát khi debug chương trình. 

(8): Đóng mở các khối mã lệnh chương trình 

(9): Hỗ trợ khi viết script 

1.3 Thiết lập môi trường làm việc 

a. Tạo mới tài liệu Flash  

Hoặc vào File > New, và có thể nhấn Ctrl+N. 
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Hình 1.3.1: Tạo mới tài liệu Flash 

Khi tạo mới một dự án trong Flash, chúng ta cần quan tâm đến một số kiểu dự án 

sau đây: 

ActionScript 3.0: Tạo dự án hỗ trợ ActionScript 3.0. Dự án này sử dụng cho 

Flash Player và Flash Plugin với nền tảng chủ yếu là Desktop. 

ActionScript 2.0: Phiên bản được hỗ trợ 2.0. 

Adobe Air : Tạo dự án Flash cho Desktop hoặc các thiết bị khác có hỗ trợ Adobe 

Air. 

AIR for Android: Tạo dự án Flash chạy trên AIR phục vụ cho các thiết bị sử 

dụng hệ điều hành Android của Google. 

AIR for iOS : Tạo dự án Flash chạy trên AIR phục vụ cho các thiết bị sử dụng hệ 

điều hành iOS của Apple. iOS SDK của Apple chỉ cung cấp cho các nhà phát triển sử 

dụng nền tảng MacOS. 
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Flash Lite 4, Adobe Device Central: Tạo dự án Flash cho Mobile chạy trên Flash 

Lite. Hỗ trợ trên các dòng điện thoại. 

b. Thiết lập các thuộc tính một tài liệu  - Setting Document Properties 

Modify / Document 

Cách hai là ta nhấn Ctrl+J, cả hai cách đều làm xuất hiện bảng thuộc tính . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 1.3.2: Thuộc tính trang tài liệu 

Dimention: Thông thường là: 800 x 600, tối đa có thể đặt: 2880 x 2880 pixel và nhỏ 

nhất là 1x1 pixel, 

Backgound color: Đặt màu nền 

Frame Rate ; 24 fps : tốc độ film. v.v...  

c. Lưu tài liệu - Saving a Document 

File Flash lưu(Save) với phần đuôi mở rộng là .fla:  

File-> Save, Crtl+S.  

Nếu muốn lưu sang một thư mục, ổ đĩa khác: File>Save as hoặc Ctrl+Shift+S 
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Hình 1.3.3: Lưu tài liệu 

Một số phím tắt thường dùng 

 

 

 

 

 

 

 

 

 

 



10 

 

 

 

 

2. Các đối tượng cơ bản       

2.1 Các đối tượng trong trang hoạt hình  

a. Công cụ Selection  (V)  

Công cụ chọn đối tượng hoặc một phần đối tượng bằng cách kích đôi chuột vào 

nó hoặc bôi đen một phần đối tượng. Công cụ cho phép kéo giãn, uốn các biên của hình 

thể ( Đặt con trỏ và các biên của hình và nó có dạng như biểu tượng Selection bổ sung 

thêm đường cong màu đen. 

Chú ý: Để chọn nhiều đối tượng giữ phím Shift. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Hình 2.1a: Công cụ Selection 

b. Công cụ SubSelection (A)  

 Hình 2.1b: Công cụ Subselection 
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Nhấp chọn biểu tượng SubSelection, sau đó bấm vào đối tượng. Khi đó đường 

viền của đối tượng sẽ hiện ra các đường Bezier cấu thành nên vật thể. Các điểm đánh 

dấu bằng chấm tròn được gọi là các điểm điều khiển đường Bezier. 

c. Công cụ Free Transform (Q)  

Tree Transform Tool (Q) 

Công cụ tinh chỉnh góc cạnh, xoay đối tượng. 

Cách sử dụng : Chọn biểu tượng trên thanh công cụ, chọn đối tượng cần hiệu 

chỉnh. 

Muốn phóng to hay thu nhỏ đối tượng, ta chỉ đặt trỏ chuột các nút đối tượng kéo 

ra ngoài nếu muốn tăng kích thước, kéo vào trong nếu muốn giảm kích thước. Nếu 

muốn xoay đối tượng, ta nhấn vào nút góc của đối tượng. 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.1c1: Công cụ Free Transform 
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Hình 2.1.c2: Thay đổi tâm quay của đối tượng 

Gradient Transform Tool (F) 

Công cụ hiệu chỉnh các thông số khi đổ màu chuyển sắc cho đối tượng, ta bấm 

chọn vào biểu tượng tam giác đen trên công cụ Free Transform, lúc này xuất hiện công 

cụ Gradient Transform, bạn chỉ việc bấm nó. 

 

 

 

 

 

 

 

 

 

Hình 2.1.c3: Công cụ Gradient Transform 

Sau đó, bấm chuột vào vùng chuyển sắc. Trên vùng màu này, sẽ hiện ra một 

dạng thức đổ màu như hình trên. Hiệu chỉnh bao của khung màu này như: kéo to ( 

tăng kích thước vùng sáng), thu nhỏ (giảm kích thước vùng sáng), bấm vào nút tròn 

và dịch chuyển nó ( thay đổi vùng màu) 

d. Công cụ Lasso (L)  

Tương tự như công cụ Selection. Công cụ Lasso cũng cho phép chọn. 
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Công cụ Lasso có thể chọn theo hình dạng phức tạp. Lasso không dùng để tinh 

chỉnh đối tượng. Khi bấm biểu tượng này, xuất hiện thêm các công cụ con bao gồm 

Wand, Magic Wand và Polygon Mode. 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.1d: Công cụ Lasso 

Magic Wand là công cụ chọn nhanh. Khi sử dụng công cụ này ta cần hiệu chỉnh 

một số thông số trong mục Magic Wand Setting: threshold – số pixel cho phép sai số khi 

chọn, smoothing – cách làm mượt nét chọn ( bao gồm: pixel, rough, normal và 

smoothing ) 

Polygon Mode là công cụ cho phép chọn theo đường gấp khúc phức tạp 

Đây là công cụ dùng để chọn trong tình huống đòi hỏi độ chính xác, tỉ mỉ để xử 

lý. Chỉ được áp dụng với các đối tượng được vẽ bằng Flash. 

e. Nhóm công cụ Pen  

 

 

 

Công cụ Pen Tool  (P)  

Công cụ dùng để vẽ các đường đa giác bằng cách tạo ra các điểm điều khiển, sau 

đó tự động nối các điểm này lại với nhau. 
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Muốn tạo hình thể dạng đường thẳng ta chỉ cần nhấp nút đầu và nút cuối 

 

 

 

 

 

 

 

 

 

 

 

 

 Hình 2.1e1: Công cụ Pen 

Công cụ Add Anchor Point (=): Bổ sung thêm điểm điều khiển cho đường 

Bezier. Muốn bổ sung điểm điều khiển chọn công cụ sau đó bấm vào một vị trí trên 

đường biên. 

Công cụ Delete Anchor Point (-): Xoá bớt điểm điều khiển cho đường Bezier. 

Muốn xoá điểm điều khiển chọn công cụ sau đó bấm vào một điểm điều khiển cần xoá 

bỏ. 

Chú ý: Việc bổ sung và xoá bỏ các điểm điều khiển rất hữu ích trong việc tạo các đường 

uốn. Ví dụ: Đối tượng Parabol, ta chỉ cần bốn điểm điều khiển 

Các điểm điều khiển là các điểm nằm trên đường biên 

 

 

 

 

 

Hình 2.1e2: Hình các điểm điều khiển 
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Công cụ Convert Anchor Point (C): Dùng để chuyển đổi vùng điều khiển góc 

cạnh thành điểm uốn cong. 

Để chuyển đổi điểm điều khiển góc cạnh thành điểm uốn cong, ta chỉ việc chọn 

công cụ và nhấp vào điểm cần chuyển đổi. Để hiệu chỉnh góc xoay cho các đường điều 

khiển, ta chỉ việc xoay các đường điều khiển. 

 

 

 

 

 

 

 

 

 

 Hình 2.1e3: Công cụ Convert Anchor Point 

f. Công cụ Text (T)  

Là công cụ dùng để soạn thảo nội dung văn bản trong Flash. 

Text Tool: Có 3 loại: 

Static Text: Văn bản cố định như nội dung của Label trong lập trình hướng đối 

tượng. 

Dynamic Text: Văn bản có thể chọn, copy nhưng không thay đổi như nội dung 

của TextBox khi hiệu chỉnh thuộc tính Readonly = True. 

Input Text: Nội dung văn bản có thể thay đổi như nội dung của TextBox khi thuộc 

tính Readonly = False. 

Character: Family: Chọn Font chữ. 

Style: Chọn dạng thức cho Font chữ in đậm , in nghiêng. 

 Size : Chọn kích thước cho Font chữ. 
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Letter Spacing: Chọn độ rộng cho kí tự trắng giữa các chữ cái. 

Color: Chọn màu cho Font chữ. 

Anti- Alias: Làm cho nét chữ trở nên mượt hơn. 

 

 

 

 

 

 

 

 

 

 Hình 2.1f: Công cụ Text 

Show Border around Text: Hiển thị đường viền xung quanh văn bản. 

SubScript và SuperScrip: Tạo chỉ số dưới (kiểu x2) và chỉ số trên (kiểu x
2
) 

Format: Căn chỉnh văn bản 

Spacing và Margin: Spacing hiệu chỉnh khoảng cách của các từ trong văn bản 

hoặc các dòng văn bản. Margin hiệu chỉnh khoảng cách bên trái hoặc bên phải của nội 

dung văn bản so với viền bên ngoài. 

g. Công cụ Line Tool (N)  

Là công cụ vẽ đường thẳng. Khi bấm vào biểu tượng này trên thanh thuộc tính sẽ 

hiện các thông số liên quan. 
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 Hình 2.1g: Công cụ Line 

 Stroke color: Chọn màu cho đường thẳng. 

 Stroke: Kích thước của nét vẽ. 

 Style: Dạng thức của nét vẽ. 

  Scale : Kéo dãn hình được vẽ. 

  Hinting: Giúp bảo vệ nét vẽ ở đường cong khỏi bị mờ. 

  Cap: Thiết lập dạng thức cho các đường kết thúc. 

  Join : Xác định cách mà hai phân đoạn của đối tượng nối với nhau. 

   Mitter : Điều khiển độ sắc nét của Mitter.  

h. Công cụ Rectangle Tool (R)  

Công cụ này dùng để vẽ hình chữ nhật và các dạng biến thể của nó. 

Thuộc tính Properties chú ý đến các thuộc tính sau: 

Stroke color: Chọn màu viền cho nét vẽ. 

Fill color : Chọn màu nền cho nét vẽ. 

Stroke : Kích thước của nét vẽ. 

Style:   Dạng thức của nét vẽ. 

Scale: Tỉ lệ nét vẽ 

 

 

 

 

 

 

Hình 2.1.h1: Công cụ Rectangle Tool 
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Công cụ Oval Tool (o)  

Vẽ các hình Oval, khi bấm chọn biểu tượng tam giác nhỏ ở phía dưới biểu tượng 

Rectangle, sẽ xuất hiện biểu tượng Oval này. 

 

 

 

 

 

 

 

 

 

Hình 2.1.h2: Công cụ Oval Tool 

Các thuộc tính tương tự như công cụ Rectangle Tool 

Công cụ Rectangle Primitive Tool (R)  

Công cụ cho phép hiệu chỉnh góc tròn hình chữ nhật. Đây là ưu điểm của công cụ này. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.1.h3: Công cụ Rectangle Primitive  

Công cụ Oval Primitive Tool (o)  
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Tương tự như công cụ Oval. Ngoài ra ta có thể hiệu chỉnh các thuộc tính góc mở, góc 

đóng, bán kính của hình vành khăn. 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.1.h4: Công cụ Oval Primitive  

Công cụ PolyStar Tool :  

Dùng để vẽ đa giác và hình sao. Khi bấm chọn công cụ này, ta chú ý các tuỳ chọn trong 

bảng thuộc tính Properties. 

Fill color: Chọn màu nền cho vật thể. 

Stroke color: Chọn màu viền cho nét vẽ. 

 

 

 

 

 

 

 

 

 

 

Hình 2.1.h5: Công cụ PolyStar Tool 

i. Công cụ Pencil Tool (Y)  

Dùng để vẽ các đối tượng bằng tay. Các thuộc tính ứng với công cụ Pencil là: 
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Stroke color : Màu của nét vẽ. 

Stroke : Kích thước của nét vẽ. 

Style : Dạng thức của nét vẽ- đường liền nét, đứt nét.. 

Scale : Tỉ lệ nét vẽ. 

Hinting : Giúp bảo vệ nét vẽ ở đường cong bị mờ. 

Cap. Thiết lập dạng thức cho đường kết thúc. 

Join : Xác định cách mà hai phân đoạn của đối tượng nối với nhau. 

Mitter : Điều khiển độ sắc nét của Mitter, khi Cap được chọn Mitter. 

 

 

 

 

 

 

 

 

 

Hình 2.1.h5: Công cụ Pencil Tool  

j. Công cụ Brush Tool (B)  

Cũng tương tự công cụ Pencil, Brush được dùng để vẽ. Có sự khác biệt là nét vẽ 

của Brush không bao gồm chỉ có màu nền, còn Pencil ngược lại chỉ có màu viền không 

có nền. Các thuộc tính của Brush bao gồm: 

Fill color : Chọn màu cho nét vẽ. 

Smoothing: Độ mềm cho nét vẽ. 

k. Công cụ Spray Brush Tool (B)  

Công cụ phun màu trong Flash. Chúng ta có thể định nghĩa mẫu màu để phun, 

các chế độ phun màu: Góc nghiêng, độ rộng, độ cao, chế độ xoay các biểu tượng theo 

góc ngẫu nhiên… 
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2.2 Khả năng thiết kế các hoạt cảnh  

2.3 Quản lý các đối tượng bằng cửa sổ Library 

Library là thư viện quản lý các đối tượng được Import và Convert. Để convert 

một đối tượng kích chuột phải vào đối tượng chọn Convert to Symbol. Khi đó biểu 

tượng sẽ xuất hiện trong Library 

Import một đối tượng từ bên ngoài vào Library ->File-> Import-> Import to 

Library. Các đối tượng được chọn đưa vào Library: 

Chọn Window > Library hoặc nhấn phím Ctrl+L, hoặc mở nhanh nhấn phím F11. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Các đối tượng nằm trong thư viện được tổ chức và quản lý theo cấu trúc cây thư 

mục. Để tổ chức và quản lý theo cây thư mục, ta cần tạo mới thư mục theo cấu trúc của 

Windows Explorer. 
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Thư viện Flash cho phép ta thực hiện thao tác kéo thả các đối tượng từ vị trí này 

sang vị trí khác 

3. Phân cảnh        

3.1 Khái niệm phân cảnh. 

Được hiểu như các cảnh quay trong Flash. Một cảnh quay là tập hợp của các 

khung hình kế tiếp nhau để tạo ra các chuyển động. 

3.2 Cách tạo phân cảnh. 

Insert / Insert Scence 

 

 

 

 

 

 

 

Các cảnh quay tạo ra các thước phim dài. Một cảnh quay trong Flash cũng giống 

như một cảnh quay trong truyền hình. Khi cần một thước phim hoàn chỉnh, chúng ta có 

thể ghép nối nhiều cảnh quay lại với nhau.  

Chú ý: Hiển thị bảng Scene : Windows ->Panels->Scene 

3.3 Sắp xếp và hiệu chỉnh phân cảnh 

Cảnh quay được ghép tự động theo thứ tự đã sắp xếp. Muốn thay đổi thứ tự cảnh 

quay 

Muốn làm xuất hiện cửa sổ quản lý các cảnh quay. 

Windows/ Other/ Panels/ Scene (Shift +F2) 
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Sắp xếp cảnh quay bằng thao tác kéo thả. Thứ tự cảnh quay sẽ diễn ra theo thứ tự 

từ trên xuống dưới. 

Khi xây dựng cảnh quay độc lập. Kiểm tra từng cảnh quay bằng cách Control / 

Test Scene (Ctrl+ Alt + Enter) 

 Phím tắt trong phần này 

 

Phím tắt Kết quả 

Ctrl+ F8 Tạo biểu tượng mới 

Ctrl+ Alt + B Kiểm tra nút nhấn ngay trên Stage 

Ctrl+ Alt + Enter Kiểm tra hoạt hình ngay trên phân cảnh hiện hành 

Shift + F2 Mở bảng kiểm soát phân cảnh 

Home Trở lại phân cảnh đầu tiên 

Page Up Trở lại phân cảnh trước đó 

Page Down Đi tới phân cảnh tiếp theo 

End Đi tới phân cảnh cuối cùng 
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BÀI 2: TẠO CHUYỂN ĐỘNG 

1. Thiết kế hoạt hình       

1.1 Các đối tượng đoạn 

1.2 Các đối tượng nút  

1.3 Gán hành động bằng  

Timeline hay còn gọi là bảng tiến trình: Chứa các khung hình (Frame), các lớp 

(Layer), các phân cảnh (Scene). Ta sử dụng bảng tiến trình (Timeline) để tổ chức và 

kiểm soát phim. 

 

 

  

 

 

 

 

 

•Playhead: Chỉ ra khung hình - Frame hiện thời trên Stage ( sân khấu- trang vẽ) 

 

 

 

Timeline Header: là thanh chứa số khung hình được đánh số từ Frame1 trở lên 

(số khung hình nhiều không có giới hạn có thể tới hàng ngàn). 

Timeline Status - Thanh trạng thái chỉ số khung hình hiện thời, tốc độ của khung 

hình(Frame Rate) 

Layer- Lớp: Tương tự như nhưng tấm film, trong suốt chồng khít lên nhau. Ta có 

thể thêm một layer mới, xóa bớt layer, khóa lớp... 

Frame: Khung hình được chia tương ứng với số khung hình bên trên. Mỗi khung 

hình có thể chứa một hay nhiều đối tượng hoạt hình. 

Một số chức năng khi làm việc với TimeLine: 

 
 

Playhead-Con trỏ khung hình 

 

Scene-Phân cảnh 

 
Timeline Header - Số khung hình 
 

Frame-khung hình 

 

Layer-Lớp 
 

 

Timeline Status - Thanh trạng thái 
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Phím F5: Chèn Frame vào thanh TimeLine tương ứng với Insert Frame. 

Phím F6: Chèn KeyFrame vào thanh TimeLine tương ứng với Insert Key Frame. 

2. Biến đổi vị trí hình vẽ      

2.1 Tạo các hình vẽ 

Sử dụng các công cụ vẽ trên thanh công cụ để tạo ra các hình vẽ. 

2.2 Biến đổi theo Tweening 

Khởi tạo một KeyFrame đầu tiên 

Sau đó nhấn F8: Biến đối tượng thành Movie Clip tại Name: Đặt tên đối tượng 

 
Nhấn F6 tại  KeyFrame 40. 
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Nhấn chuột phải vào đoạn giữa KeyFrame đầu tiên và KeyFrame: Chọn Creat Motion 

Tween:  

Nhấn Ctrl + Enter. Test kết quả. 

2.3 Trình tự các bước biến đổi  

2.4 Ví dụ ứng dụng 

3. Sự biến đổi hình dạng hình vẽ      

3.1 Các yêu cầu của biến đổi hình vẽ 

3.2 Biến đổi theo Shape  

3.3 Trình tự các bước biến đổi 

4.  Phép xoay hình       

4.1 Cách tạo phép xoay hình 

4.2 Trình tự phép xoay hình 

4.3 Ví dụ ứng dụng 
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BÀI 3: LÀM VIỆC VỚI LỚP 

1. Lớp và thiết lập lớp      

1.1 Ý nghĩa của lớp 

Mỗi một đối tượng thường được xây dựng trên một lớp (layer). Mỗi một khung 

hình có thể chứa nhiều layer khác nhau. Kỹ thuật layer được sử dụng rộng rãi trong đồ 

họa máy tính. 

 

 

 

 

 

 

 

 

 

 

1.2 Thiết lập lớp 

Có 3 cách để tạo layer mới 

* Kích vào nút Inset Layer 

* Chọn Inset>Timline>Layer  

Chọn layer muốn thêm, nhấn nút phải chuột và chọn Inset Layer từ menu . 

 

 

 

 

 

 

 

 

 

Xóa layer - Delete Layer 
* Chọn lớp cần xóa, nhấn vào nút Delete Layer 

Chọn lớp cầ xóa, nhấn phải chuột, chọn Delete Layer          từ menu ngữ cảnh. 

 

 Biểu tượng thứ nhất từ trái sang: Tạo mới Layer 
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Biểu tượng thứ hai: Tạo mới thư mục để chứa layer. 

Biểu tượng thứ ba: Xóa layer hoặc thư mục chứa layer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tổ chức lớp - Organizing  Layer 

* Thêm thư mục lớp : Nhấn vào nút thêm thư muc. 

* Đưa một lớp vào trong thư muc: Chọn lớp muốn di chuyển, kéo lên trên 

thư mục, thả phím chuột ra, lớp sẽ được chuyển vào trong thư muc. 

* Đặt lại tên cho lớp: Nhấp đúp vào lớp muốn đổi tên, Đặt lại tên mới vào. 

Đặt lại tên cho thư mục : Làm tương tự như làm với lớp  

Thu gọn và mở rộng thư mục 

 
 

Thêm lớp mới 
 

Thêm lớp dẫn 
 

Thêm Thư mục 

lớp Folder 

 

Xoá lớp 
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Nhấp vào biểu tượng Expand    để mở rộng hoặc Collape     để thu gọn. 

1.3 Hiệu chỉnh lớp 

 Biểu tượng thứ nhất từ trái sang: Ẩn hay hiện Layer đó 

Biểu tượng thứ hai: Khóa không cho phép chỉnh sửa đối tượng trên layer. 

Biểu tượng thứ ba: Hiển thị đường viền màu nền. 

2. Lớp mặt nạ       

2.1 Ứng dụng lớp mặt nạ 

Dùng để thiết lập vùng hiển thị tùy ý các hình ảnh ở các lớp bị che nằm dưới 

(Masked layer ) qua một khuôn hình ở lớp mặt nạ ở trên (mask Layer ). Trong kỹ 

thuật này bao giờ cũng có cấu trúc như sau: layer mask ở trên cùng và một hay nhiều 

lớp bị che nằm ở dưới chứa hình ảnh nền cần hiển thị. 

Bằng cách thêm vào các chuyển động cho lớp mask hay các lớp bị che, ta có thể 

tạo ra nhiều hiệu ứng thú vị như hiệu ứng đèn pha, kính lúp, chụp x-quang 
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2.2 Cách tạo lớp mặt nạ 

Lớp mặt nạ chỉ liên kết với lớp nằm ngay dưới nó. Mặt nạ che phủ các đối tượng 

trên lớp nằm ngay bên dưới.  

 

 

 

 

 

 

 

 

 

 

Để tạo lớp mặt nạ, chọn lớp tạo mặt nạ nhấn phải chuột và nhấn Mask 

 

 

 

 

 

 

2.3 Hiệu chỉnh lớp mặt nạ   

3. Lớp đường dẫn       

3.1 Ứng dụng lớp đường dẫn 

3.2 Cách tạo lớp đường dẫn 

3.3 Hiệu chỉnh lớp đường dẫn 

 

 

 

Lớp mặt nạ xuất hiện với một biểu 

tượng duy nhất 

 

Lớp mặt nạ  
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BÀI 4: XÂY DỰNG CÁC ACTION 

1. Làm việc với nút       

1.1 Cách tạo nút 

Trong Flash có 2 lớp đối tượng button: 

Simple Button: Lớp người dùng thiết kế sử dụng chức năng Convert to Symbol. 

Lớp Button còn lại sử dụng trong thư viện fl.Controls 

Cách tạo một button : 

Chọn đối tượng cần chuyển đổi sang Button. 

Nhấn F8 hoặc kích chuột phải / Convert to Symbol: Xuất hiện hộp thoại: 

 

Trong mục Type: Chọn Button 

Chú ý: Có thể tạo biểu tượng Button nhanh chóng 

Sử dụng các Button được tạo sẵn : Windows / Common Libraries / Button 

Sử dụng Commands: Tạo khối hình thể, nhấp chọn nó 

Sau đó vào Commands / Make Button. 

1.2 Các tính năng của nút 

Biểu tượng button dùng để bổ sung tương tác với movie, đáp trả các sự kiện kích 

chuột, ấn phím, kéo các thanh kéo và hành động khác. 

Biểu tượng button có 4 frame tương tác: Up, Down, Over, Hit. 
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1.3 Gán Action cho nút 

Chọn nút cần gán Action. 

Windows / Actions (F9) 

2. Xây dựng hoạt hình bằng Action   

2.1 Làm việc với cửa sổ Action 

Để hiện thị bảng action: Chọn Window>Action, hoặc nhấn F9, bảng action sẽ 

xuất hình như hình dưới: 
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2.2 Gán Action lên các Frame 

Để hiển thị bảng Action:  

Chọn khung Frame  

Windows / Action (F9) 

2.3 Các cấu trúc Action cơ bản 

3. Thư viện Action       

3.1 Nhóm Autoplay 
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Một số phím tắt 

 

 

 

 

 

 

 

3.2 Nhóm KeyPress 

Cần phải gán cho Button Intances một sự kiện key press 

bằng từ  on  ví dụ: 

on(keyPress  <Enter> ){ 

gotoAndPlay(1); 

} 

Một vài key trên bàn phím như sau:  Enter, Escape, Up, Down, Left, Right, 

Backspace... 

3.3 Nhóm Goto   

 


